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Introduction 
 

 
TerrainCAD for AutoCAD is a terrain modeling plug-in for AutoCAD. This plug-in gives 
AutoCAD the ability to generate a terrain mesh from a set of unordered points, contours and 
polylines. The terrain mesh is created as a Delaunay Triangulation, which is regarded as the 
best method to create a terrain mesh from unorganized point data. TerrainCAD for AutoCAD 
can also import a set of points from a text file containing point coordinate data. 
 
TerrainCAD for AutoCAD can solidify a terrain mesh by giving it thickness. It also has a 
command to calculate the mass properties of a mesh such as volume and surface area. 
 
TerrainCAD for AutoCAD is powered by TerrainLib, a state of the art terrain mesh 
generation, editing and modeling library developed by SYCODE. TerrainLib employs blazing 
fast algorithms and cutting-edge technology to yield superior terrain models in very less 
time. 
 
TerrainCAD for AutoCAD is designed to work with the following versions of AutoCAD: 

• AutoCAD 2011 (32 & 64 Bit) 

• AutoCAD 2010 (32 & 64 Bit) 

• AutoCAD 2009 (32 & 64 Bit) 

• AutoCAD 2008 (32 & 64 Bit) 

• AutoCAD 2007 

• AutoCAD 2006 

• AutoCAD 2005 

• AutoCAD 2004 

• AutoCAD 2002 

• AutoCAD 2000i 

• AutoCAD 2000 

  
TerrainCAD for AutoCAD is very easy to use. Once installed, it must be loaded into the 
AutoCAD environment. There are simple instructions for this in the ReadMe file. Once loaded 
it adds new commands to AutoCAD's existing commands and a new submenu called 
"TerrainCAD" to the AutoCAD menu containing these newly added commands. 
 
TerrainCAD for AutoCAD comes with detailed documentation for each command as well as a 
set of tutorials to get you started in the shortest possible time. 
 

If you need any additional information please contact SYCODE. 
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TerrainCAD for AutoCAD Help 

 
Welcome to TerrainCAD for AutoCAD Help! 

 

This help file provides all the information you need to understand and use TerrainCAD for 
AutoCAD. Click the links below or use the Contents tab on the left to browse help topics. 
You can also scroll the topics on the above right hand pane.  

 

The TerrainCAD for AutoCAD help file is divided into the following sections: 
  

• Introduction - Introduction to TerrainCAD for AutoCAD. 

• Command Reference - Quick reference of all the commands added by TerrainCAD for 
AutoCAD. 

• Tutorials - Tutorials to get you started in the shortest possible time. 

 

If you need any additional information please contact SYCODE. 

 

Note:  

 If you are having trouble loading the TerrainCAD for AutoCAD plug-in file into the 
AutoCAD environment please refer to the ReadMe file. 

 Please read the License Agreement before using the software. 

 Please check out TerrainCAD, our terrain mesh generation, editing and modeling 
software. TerrainCAD is a standalone product and does not need AutoCAD or any 
other software. 

http://www.terraincad.com/�
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This is the TerrainCAD for AutoCAD ReadMe file. 
 
   
Thank you for installing TerrainCAD for AutoCAD. 
  
Please read this ReadMe document carefully and completely. It contains 
important information which is vital to the proper working of TerrainCAD 
for AutoCAD. 
  
Since TerrainCAD for AutoCAD is a plug-in for AutoCAD, it has to be loaded 
into the AutoCAD environment before it can be used. Loading is a one time 
process. TerrainCAD for AutoCAD will automatically load itself into AutoCAD 
the next time you run AutoCAD. 
  
The TerrainCAD for AutoCAD plug-in files are installed into the TerrainCAD 
for AutoCAD installation folder (typically "C:\Program 
Files\SYCODE\TerrainCAD for AutoCAD\"). The plug-in files have an extension 
of ".arx".  
  
The list of plug-in files along with the version of AutoCAD is shown below. 
Please be sure to use the plug-in file that corresponds to your version of 
AutoCAD. 
 
TerrainCAD_VC60.arx    -> AutoCAD 2000, 2000i, 2002 
TerrainCAD_VC70.arx    -> AutoCAD 2004, 2005, 2006 
TerrainCAD_VC80.arx    -> AutoCAD 2007, 2008 (32 Bit), 2009 (32 Bit) 
TerrainCAD_VC80x64.arx -> AutoCAD 2008 (64 Bit), 2009 (64 Bit) 
TerrainCAD_VC90.arx    -> AutoCAD 2010 (32 Bit) 
TerrainCAD_VC90x64.arx -> AutoCAD 2010 (64 Bit) 
TerrainCAD_VC90.arx    -> AutoCAD 2011 (32 Bit) 
TerrainCAD_VC90x64.arx -> AutoCAD 2011 (64 Bit) 
   
To load TerrainCAD for AutoCAD into AutoCAD please follow the steps listed 
below: 
(1) Select "Load Application..." from "Tools" menu or enter the "_APPLOAD" 
command. 
(2) Click the "Contents" button in "Startup Suite" 
(3) Click the "Add" button. 
(4) Browse for the plug-in file for your version of AutoCAD (see list 
above). 
(5) Click the "Add" button on the Add File to Startup Suite dialog box. 
(6) Click the "Close" button to close the Startup Suite dialog box. 
(7) Click the "Close" button to close the Load/Unload Applications dialog 
box. 
Now TerrainCAD for AutoCAD is completely installed and ready for use. 
  
Usage: 
====== 
TerrainCAD for AutoCAD adds new commands to AutoCAD. It also adds a new 
menu called "TerrainCAD" to the AutoCAD menu containing these newly added 
commands. The commands added are: 
1) TCImportPoints - Imports points from a text file. 
2) TCCreateTerrain - Creates a terrain mesh from a set of unordered points. 



TerrainCAD for AutoCAD 

4 

3) TCSolidifyTerrain - Solidifies a terrain mesh. 
4) TCMeshProperties - Display mesh properties. 
5) TCMeshMerge - Merge meshes into a single mesh. 
6) TCHelp - Displays the TerrainCAD for AutoCAD help file. 
7) TCRegister - Registers your copy of TerrainCAD for AutoCAD. 
8) TCAbout - Displays the TerrainCAD for AutoCAD about box. 
The TerrainCAD for AutoCAD help file is a good place to start. 
  
Support: 
======== 
For support, please E-Mail support@sycode.com 
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TerrainLib 

 
TerrainLib is a state of the art terrain mesh generation, editing and modeling library 
developed by SYCODE. This library gives TerrainCAD for AutoCAD its terrain modeling 
capabilities. 

One of the salient features of TerrainLib is its ability to create a terrain mesh from a set of 
unordered survey points. The mesh is created as a Delaunay Triangulation. TerrainLib 
employs blazing fast algorithms and cutting-edge technology to yield superior terrain 
models in no time. 

 

For more information on TerrainLib, please contact SYCODE. 

 

http://www.sycode.com/�
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Delaunay Triangulation 

 
A triangulation is the division of a set of points into a set of triangles, usually with the 
restriction that each triangle side is entirely shared by two adjacent triangles. 

A Delaunay Triangulation of a set of points is a triangulation with the property that every 
edge is contained in a circle that contains no other points of the set. This implies that the 
circumcircle, or outcircle, of each triangle contains no other points from the set. The 
Delaunay Triangulation guarantees that the smallest angle will be maximal which gives well 
shaped triangles. 

 

Interesting Fact:  One would hope that the Delaunay Triangulation would be the result of 
repeatedly joining the two closest points unless doing so would cross an edge you already 
have, but sadly that turns out not to be the case. For example, take a kite with its head 
angle close to 180 degrees and its tail angle quite small. The two closest points are the side 
points, but the Delaunay Triangulation joins the head to the tail. 
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Contact 

 
 
Mailing address S1/116, Nova Cidade Complex, 

NH 17, Alto Porvorim,  
Goa - 403521  
India  

Phone +91 9822689298 
Fax +91 832 2416615 
E-Mail info@sycode.com 

Web Site http://www.sycode.com 

mailto:info@sycode.com�
http://www.sycode.com/�
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License Agreement 
 

 
 

SYCODE END USER LICENSE AGREEMENT 
 

READ CAREFULLY: SYCODE LICENSES THIS SOFTWARE TO YOU ONLY UPON THE 
CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS SOFTWARE 
LICENSE AGREEMENT. 
 
BY SELECTING THE "I ACCEPT" BUTTON AT THE END OF THIS AGREEMENT OR BY 
COPYING, INSTALLING, UPLOADING, ACCESSING OR USING ALL OR ANY PORTION OF 
THE SOFTWARE YOU AGREE TO ENTER INTO THIS AGREEMENT.  A CONTRACT IS THEN 
FORMED BETWEEN SYCODE AND EITHER YOU PERSONALLY, IF YOU ACQUIRE THE 
SOFTWARE FOR YOURSELF, OR THE COMPANY OR OTHER LEGAL ENTITY FOR WHICH 
YOU ARE ACQUIRING THE SOFTWARE. 
 
IF YOU DO NOT AGREE OR DO NOT WISH TO BIND YOURSELF OR THE ENTITY YOU 
REPRESENT: (A) DO NOT COPY, INSTALL, DOWNLOAD, ACCESS OR USE THE 
SOFTWARE; (B) SELECT "I REJECT" AT THE END OF THIS AGREEMENT (WHICH WILL 
CANCEL THE LOADING OF THE SOFTWARE); AND (C) WITHIN THIRTY (30) DAYS FROM 
THE DATE OF ACQUISITION, RETURN THE SOFTWARE TO THE LOCATION WHERE YOU 
ACQUIRED IT FOR A REFUND. 
 
COPYING OR USE OF THIS SOFTWARE OR ANY ACCOMPANYING DOCUMENTATION 
EXCEPT AS PERMITTED BY THIS AGREEMENT IS UNAUTHORIZED AND CONSTITUTES A 
MATERIAL BREACH OF THIS AGREEMENT AND AN INFRINGEMENT OF THE COPYRIGHT 
AND OTHER INTELLECTUAL PROPERTY RIGHTS IN SUCH SOFTWARE AND 
DOCUMENTATION. IF YOU COPY OR USE ALL OR ANY PORTION OF THIS SOFTWARE OR 
ITS USER DOCUMENTATION WITHOUT ENTERING INTO THIS AGREEMENT OR 
OTHERWISE OBTAINING WRITTEN PERMISSION OF SYCODE, YOU ARE VIOLATING 
COPYRIGHT AND OTHER INTELLECTUAL PROPERTY LAW.  YOU MAY BE LIABLE TO 
SYCODE AND ITS LICENSORS FOR DAMAGES, AND YOU MAY BE SUBJECT TO CRIMINAL 
PENALTIES. 
 
 
1. DEFINITIONS 
 
1.1 "Access" means to use or benefit from using the functionality of the Software. 
 
1.2 "Computer" means a single electronic device with one or more central processing 
units (CPUs) that accepts information in digital or similar form and manipulates the 
information for a specific result based on a sequence of instructions.  
 
1.3 "Install" means to place a copy of Software onto a hard disk or other storage medium 
through any means (including, but not limited to, use of an installation utility application 
accompanying the Software). 
 
1.4 "License Parameters" means the definition and limitation of the applicable license 
scope in Section 2.2 hereof. 
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1.5 "Permitted Number" means a number relevant for the applicable License Parameters 
that SYCODE may specify in the applicable User Documentation. The Permitted Number 
is one (1) unless otherwise provided by SYCODE in writing. 
 
1.6 "Software" means the computer program in which this Agreement is embedded or 
that is delivered prepackaged with this Agreement. 
 
1.7 "User Documentation" means the explanatory printed or electronic materials that 
SYCODE or its authorized distributor incorporates in or delivers in or on a package with 
the Software or sends to You on an invoice, via email, facsimile or otherwise after You 
acquire or Install the Software, including, but not limited to, license specifications, 
activation key, license files, instructions on how to use the Software, and/or technical 
specifications. 
 
1.8 "You" means you personally (i.e., the individual who reads and is prompted to accept 
this Agreement) if you acquire the Software for yourself or the company or other legal 
entity for whom you acquire the Software. 
 
 
2. SOFTWARE LICENSE 
 
2.1 License Grant. SYCODE grants You a non-sublicensable, non-exclusive, non-
transferable, limited license to use copies of the Software in the jurisdiction in which you 
acquire the Software, in accordance with the applicable User Documentation, within the 
scope of the License Parameters. SYCODE’s license grant is conditioned on Your 
continuous compliance with all license limitations and restrictions described in this 
Agreement.  If You violate any of these limitations or restrictions, the license grant will 
automatically and immediately expire.  The license descriptions in this Section 2 define 
the scope of rights that SYCODE grants to You.  Any usage of the Software outside the 
scope of the applicable license grant constitutes an infringement of SYCODE’s intellectual 
property rights as well as a material breach of this Agreement. 
 
2.2 License Parameters.  SYCODE’s license grant is subject to one or more of the License 
Parameters defined in this Section 2.2 as specified in the User Documentation.  Unless 
SYCODE expressly specifies or agrees otherwise in the User Documentation, all Software 
shall be governed solely by a license for Standalone (Individual) Versions (see Section 
2.2.1). 
 
2.2.1 Standalone (Individual) Version.  If SYCODE identifies the Software as a 
"Standalone Version" or as an "Individual Version" or if the User Documentation does not 
identify the Software by any of the version designations set forth in Sections 2.2.2 
through 2.2.6, You may Install and Access one (1) copy of the Software on one (1) 
individual Computer, which may not be connected to a network in a manner that allows 
more than one (1) user to access, upload, operate, view or otherwise create or use a 
copy of the Software.  You may not install or access the Software other than on one (1) 
computer at a time. 
 
2.2.2 Network Version.  If SYCODE identifies the Software as a "Network Version" in the 
applicable User Documentation, You may Install, Access and use one (1) copy of the 
Software on Your Computer file server, for Your own internal business needs, with the 
SYCODE License Manager tool.  The Software may be Installed on or Accessed by other 
Computers, or on an individual Computer, as a multiple-user installation, so long as the 
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maximum number of concurrent users does not to exceed the Permitted Number. 
 
2.2.3 Educational Institutional Version. If SYCODE identifies the Software as an 
"Educational Institutional Version" in the applicable User Documentation, You may Install 
and Access a single copy of the Software on up to the Permitted Number of Computers, 
only for educational purposes (as further specified in the applicable User Documentation) 
and for no other purpose.  Without limiting the foregoing, Educational Institutional 
Versions of the Software may not be used for commercial, professional, or for-profit 
purposes.  Additionally, functional limitations apply, as set forth in Section 6. 
 
2.2.4 Student Version. If SYCODE identifies the Software as a "Student Version" in the 
applicable User Documentation, You may Install and Access a single copy of the Software 
on up to the Permitted Number of Computers, only for personal learning purposes, and 
no other purpose.  Unless otherwise provided by SYCODE in the User Documentation, 
Student Versions of the Software may be used for a period of one (1) year from the date 
of Installation. Without limiting the foregoing, Student Versions of the Software may not 
be used for commercial, professional or other for-profit purposes and may only be used 
by persons who qualify as a permitted user of Student Versions (as further specified in 
the applicable User Documentation for the jurisdiction in which the Software is acquired). 
Additionally, functional limitations apply, as set forth in Section 6. 
 
2.2.5 Evaluation Version. If SYCODE identifies the Software as a demonstration, 
evaluation, trial, or not for resale version ("Evaluation Version") in the applicable User 
Documentation, You may Install and Access one copy of the Software only for the 
purpose of commercial evaluation and demonstration.  Without limiting the foregoing, 
You may not use it for competitive analysis, or commercial, professional, or for-profit 
purposes. The Evaluation Version may only be Installed for a ten (10) day evaluation 
period, unless otherwise specified by SYCODE in writing.  Additionally, functional 
limitations apply, as set forth in Section 6. 
 
2.2.6 License Term. Subject to the terms and conditions of this Agreement, the license to 
use the Software is perpetual, unless the Software qualifies as an Evaluation Version, 
Student Version, or is designated as a fixed-term license, a limited duration license or a 
rental license.  In such case, the term of the license shall be the term identified by 
SYCODE in the applicable User Documentation (the "Designated Term") or the term for 
which You have paid, whichever is less.  If SYCODE identifies the Software as licensed for 
a fixed term, limited duration or rental and does not specify a term, then the Designated 
Term shall expire thirty (30) days after the date You first Install the Software. Use of this 
Software beyond the applicable license term, or any attempt to defeat the time-control 
disabling function in the Software is an unauthorized use and constitutes a material 
violation of this Agreement and intellectual property law. 
 
2.3 Software Components.  The Software is licensed to You as a single product and its 
components may not be separated for distribution or use on more than one (1) 
Computer unless expressly permitted by SYCODE in the applicable User Documentation. 
 
 
3. PERMITTED AND PROHIBITED ACTIONS 
 
3.1 Permitted Actions 
 
3.1.1 Backup Copy. Regardless of which version of the Software You have acquired, You 
may Install one archival (backup) copy of the Software. Such archival copy may not be 
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Installed on another Computer, unless such other Computer is a partitioned drive of a 
server to which only the user of the active copy of the Software can Access. In any 
event, the archival copy may not be Accessed as long as another copy of the Software is 
Installed on any Computer. Except as expressly permitted under Section 2.2: (a) if the 
User Documentation is in printed form, it may not be copied; and (b) if the User 
Documentation is in electronic form, it may not be duplicated electronically. 
 
3.1.2 Additional Installation. Except with regard to Educational Institutional, Student and 
Evaluation Versions only, You may Install and Access a second copy of the Software on 
the hard disk of a second Computer owned by You or under Your control provided that: 
 
(i) the original and second copies are used only by the same person; 
 
(ii) the second copy is Installed and Accessed only on either (a) with respect to Network 
Versions, a redundant server that makes the Software available for use only when Your 
primary server on which the active Software copy is Installed becomes inoperable, or (b) 
a notebook computer or other non-server computer away from Your usual work location 
for the purpose of enabling You to perform work while away from Your usual work 
location;  
 
(iii) only one of the Software copies is Accessed at any one time; and 
 
(iv) both copies of the Software are Installed and Accessed exclusively with the copy 
protection device (if any) supplied with the Software. 
 
(v) You have an active Subscription for the Software. 
 
3.2 Prohibited Actions. SYCODE does not permit any of the following actions and You 
acknowledge that such actions shall be prohibited: 
 
3.2.1 Use. You may not Install, Access or otherwise copy or use the Software or User 
Documentation except as expressly authorized by this Agreement. 
 
3.2.2 Reverse Engineering. You may not reverse engineer, decompile, or disassemble the 
Software. 
 
3.2.3 Transfers. You may not distribute, rent, loan, lease, sell, sublicense, or otherwise 
transfer all or any portion of the Software or User Documentation, or any rights granted 
in this Agreement, to any other person without the prior written consent of SYCODE. 
 
3.2.4 Hosting or Third Party Use. You may not Install or Access, or allow the Installation 
or Access of, the Software over the Internet, including, without limitation, use in 
connection with a Web hosting or similar service, or make the Software available to third 
parties via the Internet on Your computer system or otherwise. 
 
3.2.5 Distribution. You may not distribute the Software to another party, without prior 
written permission from SYCODE. Distribution includes, but is not limited to, sending the 
Software by electronic mail, placing the Software on a web server or a similar on-line 
source, including the software on a CD or any other media or any other distribution 
mechanism. 
 
3.2.6 Notices. You may not remove, alter, or obscure any proprietary notices, labels, or 
marks from the Software or User Documentation. 
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3.2.7 Modifications. You may not modify, translate, adapt, arrange, or create derivative 
works based on the Software or User Documentation for any purpose.  
 
3.2.8 Circumvention. You may not utilize any equipment, device, software, or other 
means designed to circumvent or remove any form of copy protection used by SYCODE 
in connection with the Software, or use the Software together with any, activation code, 
serial number, or other copy protection device not supplied by SYCODE directly or 
through an authorized distributor. 
 
3.2.9 Export. You may not export the Software or User Documentation in violation of this 
Agreement, Indian or other applicable export control laws. 
 
 
4. ALL RIGHTS RESERVED 
 
Except as expressly provided otherwise in this Agreement, title, ownership and all rights 
and interest including, without limitation, copyrights, in and to the Software and User 
Documentation and any authorized copies made by You remain with SYCODE and its 
licensors. The structure, organization, and code of the Software are valuable trade 
secrets of SYCODE and its licensors and You shall keep such trade secrets confidential. 
The Software and User Documentation are licensed, not sold. 
 
 
5. DISCLAIMER 
 
ANY STATEMENTS OR REPRESENTATIONS ABOUT THE SOFTWARE AND ITS 
FUNCTIONALITY IN THE USER DOCUMENTATION OR ANY COMMUNICATION WITH YOU 
CONSTITUTE TECHNICAL INFORMATION AND NOT AN EXPRESS WARRANTY OR 
GUARANTEE.  IN ADDITION, SYCODE SPECIFICALLY DISCLAIMS ANY OTHER WARRANTY 
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTY OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. WITHOUT LIMITING 
THE FOREGOING, SYCODE DOES NOT WARRANT THAT THE OPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE. 
 
6. WARNINGS 
 
6.1 Functionality Limitations. COMPUTER AIDED DESIGN SOFTWARE AND OTHER 
TECHNICAL SOFTWARE ARE TOOLS INTENDED TO BE USED BY TRAINED 
PROFESSIONALS ONLY. THEY ARE NOT SUBSTITUTES FOR YOUR PROFESSIONAL 
JUDGMENT. COMPUTER AIDED DESIGN SOFTWARE AND OTHER TECHNICAL SOFTWARE 
ARE INTENDED TO ASSIST WITH PRODUCT DESIGN AND ARE NOT SUBSTITUTES FOR 
INDEPENDENT TESTING OF PRODUCT STRESS, SAFETY AND UTILITY. DUE TO THE 
LARGE VARIETY OF POTENTIAL APPLICATIONS FOR THE SOFTWARE, THE SOFTWARE 
HAS NOT BEEN TESTED IN ALL SITUATIONS UNDER WHICH IT MAY BE USED. SYCODE 
SHALL NOT BE LIABLE IN ANY MANNER WHATSOEVER FOR THE RESULTS OBTAINED 
THROUGH THE USE OF THE SOFTWARE. PERSONS USING THE SOFTWARE ARE 
RESPONSIBLE FOR THE SUPERVISION, MANAGEMENT AND CONTROL OF THE 
SOFTWARE. THIS RESPONSIBILITY INCLUDES, BUT IS NOT LIMITED TO, THE 
DETERMINATION OF APPROPRIATE USES FOR THE SOFTWARE AND THE SELECTION OF 
THE SOFTWARE AND OTHER PROGRAMS TO ACHIEVE INTENDED RESULTS.  PERSONS 
USING THE SOFTWARE ARE ALSO RESPONSIBLE FOR ESTABLISHING THE ADEQUACY OF 
INDEPENDENT PROCEDURES FOR TESTING THE RELIABILITY AND ACCURACY OF ANY 
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PROGRAM OUTPUT, INCLUDING ALL ITEMS DESIGNED BY USING THE SOFTWARE. 
 
 
6.2 Activation Key Required. 
 
6.2.1 INSTALLATION, ACCESS, TRANSFERS AND CONTINUED USE OF THE SOFTWARE 
MAY REQUIRE AN ACTIVATION KEY. YOU MUST REGISTER YOUR ACQUISITION OF THE 
SOFTWARE WITH SYCODE BEFORE AN ACTIVATION KEY IS ISSUED TO YOU.  
 
6.2.2 THE ACTIVATION SECURITY MECHANISMS MAY DISABLE THE SOFTWARE IF YOU 
TRY TO TRANSFER IT TO ANOTHER COMPUTER, IF YOU TAMPER WITH THE DATE 
SETTING MECHANISMS ON YOUR COMPUTER, IF YOU USE THE SOFTWARE PAST AN 
APPLICABLE EVALUATION PERIOD OR LIMITED TERM, OR IF YOU UNDERTAKE CERTAIN 
OTHER ACTIONS THAT MAY OFFSET THE SECURITY MODE. MORE INFORMATION IS 
CONTAINED IN THE APPLICABLE USER DOCUMENTATION OR AVAILABLE FROM SYCODE 
ON REQUEST.  
 
 
7. LIMITATION OF LIABILITY 
 
IN NO EVENT SHALL SYCODE OR ITS LICENSORS HAVE ANY LIABILITY FOR ANY 
INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS, 
REVENUE, DATA, OR COST OF COVER.  IN ADDITION, IN NO EVENT SHALL THE 
LIABILITY OF SYCODE OR ITS LICENSORS FOR ANY DAMAGES ARISING OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THIS AGREEMENT EXCEED THE AMOUNT PAID 
OR PAYABLE BY YOU FOR THE SOFTWARE PRINCIPALLY RESPONSIBLE FOR SUCH 
DAMAGES. THE LIMITATIONS OF LIABILITY IN THIS SECTION 7 SHALL APPLY TO ANY 
DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, 
WHETHER DERIVED FROM CONTRACT, TORT (INCLUDING, BUT NOT LIMITED TO, 
NEGLIGENCE), OR OTHERWISE, EVEN IF SYCODE HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES AND REGARDLESS OF WHETHER THE LIMITED 
REMEDIES AVAILABLE HEREUNDER FAIL OF THEIR ESSENTIAL PURPOSE. 
 
 
8. GENERAL 
 
8.1. No Assignment; Insolvency. This Agreement and any rights hereunder are non-
assignable and any purported assignment shall be void. The Agreement and the licenses 
granted hereunder shall terminate without further notice or action by SYCODE if You 
become bankrupt or insolvent, make an arrangement with Your creditors or go into 
liquidation.  
 
8.2. Choice of Law. This Agreement and any disputes arising out of or in connection with 
this Agreement shall be governed by the laws of the state of Goa in India without 
reference to conflict-of-laws principles and excluding the UN Convention on Contracts for 
the International Sale of Goods.  
 
8.3 Entire Agreement. This Agreement and the applicable User Documentation constitute 
the entire agreement between You and SYCODE and supersede any other previous or 
contemporaneous communications, agreements, representations, or advertising with 
respect to the Software and User Documentation. 
 
8.4 Severability. If and to the extent any provision of this Agreement is held illegal, 
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invalid, or unenforceable in whole or in part under applicable law, such provision or such 
portion thereof shall be ineffective as to the jurisdiction in which it is illegal, invalid, or 
unenforceable to the extent of its illegality, invalidity, or unenforceability and shall be 
deemed modified to the extent necessary to conform to applicable law so as to give the 
maximum effect to the intent of the parties. The illegality, invalidity, or unenforceability 
of such provision in that jurisdiction shall not in any way affect the legality, validity, or 
enforceability of any other provision of this Agreement in any other jurisdiction. 
 
8.5 Audits. To ensure compliance with this Agreement, You agree that upon reasonable 
notice, SYCODE or SYCODE’s authorized representative shall have the right in inspect 
and audit Your Installation, Access and use of the Software.  Any such inspection or audit 
shall be conducted during regular business hours at Your facilities or electronically. If 
such inspections or audits disclose that You have Installed, Accessed or permitted Access 
to the Software on Computer(s) in a manner that is not permitted under this Agreement, 
then SYCODE may terminate this Agreement immediately and You are liable to pay for 
any unpaid license fees as well as the reasonable costs of the audit.  Nothing in this 
section shall be deemed to limit any legal or equitable remedies available to SYCODE for 
violation of this Agreement or applicable law.  
 
8.6 Language. The English language version of this Agreement is legally binding in case 
of any inconsistencies between the English version and any translations. 
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Command Reference 
 

 
TerrainCAD for AutoCAD adds a new submenu to the AutoCAD menu called 'TerrainCAD'. 
The TerrainCAD menu consists of the following commands: 

 

TCImportPoints Import points from a text file 
TCCreateTerrain Create a mesh from a set of unordered points 
TCSolidifyTerrain Solidifies a terrain mesh. 
Tools  
     TCMeshProperties Display mesh properties. 
     TCMeshMerge Merge meshes into a single mesh. 
TCHelp Displays the TerrainCAD for AutoCAD help file 
TCRegister Registers your copy of TerrainCAD for AutoCAD 
TCAbout Displays the TerrainCAD for AutoCAD about box 
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TCImportPoints 

 
Menu Button TerrainCAD > Import Points 
Command  TCImportPoints 

 
This command is used to imports points from a text file. This command invokes the Point 
File dialog (shown below) which allows you to select the point file to import and set the file 
format and delimiters. 

 

To import Points 
 
1. Click Import Points from the "TerrainCAD" submenu or type TCImportPoints at the 
AutoCAD command prompt. 
 
2. The "Point File" dialog box is displayed. Browse for the Point file you wish to import.  At 
the "Open" dialog box select the file and click Open.  Select the format and delimiters in the 
"Point File" dialog box and click OK. 
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Explanation 

Format 
Each line of the text file is assumed to contain data related to a single point. The point data 
must contain the X, Y and Z coordinates of the point and may contain a point number and 
point description. The point number (if it exists) must be present before and coordinate data 
and the point description (if it exists) must be present after the coordinate data. The point 
coordinates can be in the X, Y, Z format or the Northing, Easting, Elevation (Y, X, Z) format. 
The general format can be described as: 
  

[Point Number] [Point Coordinates] [Point Description] 
  
Delimiters 
The most commonly used delimiters are Tab, Semicolon, Comma and Space. You can 
specify a custom delimiter as well. 
  

How it works 
Browse for the text file by clicking the "Browse" button. After selecting the text file the 
Preview list box will show you the first 100 lines of the text file. Then proceed to select the 
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format of the text file by selecting the appropriate value from the Format drop list. Also 
select/unselect the delimiters. The output list box will show you the points read from the 
text file based on the current values of format and delimiters. When you are satisfied with 
the contents of the output list box click the OK button and the points will be imported into 
AutoCAD. 

 

Note: 

• Point numbers and descriptions are not imported. 
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TCCreateTerrain 

 
Menu Button TerrainCAD > Create Terrain 
Command Name TCCreateTerrain 

 
This command creates a terrain mesh from a set of unordered survey points, contours and 
polylines. The mesh is created as a Delaunay Triangulation. 
 
The mesh topology can be adjusted by using a search radius. The search radius determines 
whether two points can be part of the same triangular face. If the distance between two 
points is larger than the search radius then they are not connected by a face. This is 
particularly useful when creating a mesh from a set of points that has a convex boundary 
 

To Create a Terrain 

1. Click Create Terrain from the "TerrainCAD" submenu or type TCCreateTerrain at the 
AutoCAD command prompt. 

2. At the AutoCAD "Select points, lines and polylines" command prompt, select the points 
and press Enter. 

3. At the AutoCAD "TerrainCAD Options" command prompt, set the "Search radius"  as 
required and press Enter. 

4. At the AutoCAD "TerrainCAD Options" command prompt, set the "Respect breaklines"  as 
required and press Enter. 

5. At the AutoCAD "TerrainCAD Options" command prompt, set the "Respect contours"  as 
required and press Enter. 

 

 
The figure above shows a set of unordered points. 

   
The figure below shows a polyface mesh created from the unordered points that satisfies 
the Delaunay Triangulation criteria. 
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Wireframe view of the terrain mesh 

 

 
Shaded view of the terrain mesh 

 

Note:  

• A search radius of zero will remove the connectivity constraint and all points will be 
connected however far they may be from each other.  

• AutoCAD does not allow a polyface mesh to contain more than 32,000 vertices or 
faces. Due to this AutoCAD limitation, TerrainCAD for AutoCAD will break down 
polyface meshes containing more than 32,000 into a set of 3D face entities. 
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TCSolidifyTerrain 
 

Menu Button TerrainCAD > Solidify Terrain 
Command  TCSolidifyTerrain 

 
This command is used create a solid from the terrain mesh by giving it thickness.   
 
 
The terrain is an open mesh, which means that it bounded by boundary edges. In order to 
build a model of the terrain by rapid prototyping or similar processes, it becomes necessary 
to give the mesh surface a volume. 
 

To solidify a terrain: 

1. Carry out steps 1 to 6 in Tutorial 1.  
 
2. Select Solidify Terrain from the "TerrainCAD" submenu or type TCSolidifyTerrain at the 
AutoCAD command prompt and press Enter.   
 
3. At the AutoCAD "Select terrain meshes to solidify" command prompt, select all the 
meshes and press Enter. 
 
4. At the AutoCAD "TerrainCAD Options" command prompt set the option as required and 
press Enter.  
 
The mesh is solidified by a specified depth. The bottom of the solidified mesh can be flat or 
exactly the same as the top surface. When a flat bottom is chosen the depth is measured 
from the lowest vertex of the original terrain. When a flat bottom is not chosen, the bottom 
surface is same as the top surface and below it at the distance specified by the depth. 

 

The figure below shows a terrain. 
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The figure below shows the above terrain solidified to a depth of 70 with a flat bottom. 

 

 
 

Note: Solidification is usually the last command while editing a terrain. Most of the other 
commands will not work properly once the terrain is solidified. This is because almost all 
commands assume that the terrain is an open mesh. 
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Tools 

TCMeshProperties 

 
Menu Button TerrainCAD > Tools > Mesh Properties  
Command  TCMeshProperties 

 
This command displays the Mesh Properties dialog box.  
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TCMeshProperties 

 
Menu Button TerrainCAD > Tools > Mesh Properties  
Command  TCMeshProperties 

 
This command displays the Mesh Properties dialog box.  
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TCMeshMerge 

 
Menu Button TerrainCAD > Tools > Mesh Merge 
Command  TCMeshMerge 

 
This command is used to merge more than one mesh into a single mesh. 
 
  
To merge into a single Mesh 
  
1. Select Mesh Merge from "TerrainCAD----->Tools" submenu or type MSMeshMerge at the 
AutoCAD command prompt and press Enter. 
  
2  At the "Select meshes" command prompt select the meshes and press Enter. The 
selected meshes are combined into a single mesh   
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TCHelp 

 
Menu Button TerrainCAD > Help 
Command  TCHelp 

 
This command displays the help file. The Welcome page is a good place to start. 
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TCAbout 

 
Menu Button TerrainCAD > About  
Command  TCAbout 

 
This command is used to display the TerrainCAD for AutoCAD about box. The about box lists 
the software and its version. 
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TCRegister 

 
Menu Button TerrainCAD > Register 
Command TCRegister 

 
This command is used to register your copy of TerrainCAD for AutoCAD 
 
You need a license key to start using the software. A license key can be of two types: Trial 
or Permanent. A trial key is issued to you instantly and completely free of cost so that you 
may try the software before you purchase a license. A permanent key is issued after you 
have purchased a license. 

 

 
 

How do I get a Trial Key? 

Simply click the 'Request Key' button and select 'TRIAL KEY' as the type of key being 
requested. Fill the form and submit it. A trial key will be immediately sent to you by email. 
 
How do I get a Permanent Key? 

To get a permanent key you need to have already purchased a license. If you have not yet 
purchased a license you can do so by clicking the 'Buy Online' button. After you place your 
order click the 'Request Key' button and select 'PERMANENT KEY' as the type of key being 
requested. Fill the form and submit it. Your order will be verified and a permanent key will 
be sent to you by email within one business day. 
 
IMPORTANT: 



Command Reference 

29 

(1) Please ensure that your computer is connected to the internet before you request for a 
key. 

(2) Please be sure to enter a valid email address as the key will be sent to you by email. 

(3) To avoid disruption in your work-flow we urge you to place your order before the trial 
period ends. 
 
  

If you need anything else please send an email to register@sycode.com 

mailto:register@sycode.com�
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Tutorials 
 

 
Using TerrainCAD for AutoCAD is as easy as selecting points. The purpose of these tutorials 
is to provide the necessary information and hands-on experience to enable you to create 
meshes using TerrainCAD for AutoCAD 

 

The tutorials are designed to get you started with TerrainCAD for AutoCAD in the shortest 
possible time. 

• Tutorial 1: Create a terrain mesh from points 

• Tutorial 2: Effect of search radius  

• Tutorial 3: Create a terrain mesh from contours 

• Tutorial 4: Using breaklines 

 

Note: 

• The files used in these tutorials can be found in the Samples folder. (Typically 
C:\Program Files\SYCODE\TerrainCAD for AutoCAD\Samples\) 
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Tutorial 1 - Create a terrain mesh from points 

 
In this tutorial we will learn how to create a terrain mesh from a set of unordered points. 

 

Step 1: Start AutoCAD. 
 
Step 2:  Select Import Points from the "TerrainCAD" submenu or type TCImportPoints at 
the AutoCAD command prompt and press Enter. 
 
Step 3: The "Point File" dialog box is displayed. Browse for the file typically located at 
"C:\Program Files\SYCODE\TerrainCAD for AutoCAD\Samples\Sample1.txt" and click Open. 
  

 

   
 Step 4: Select the format and delimiters in the "Point File" dialog box and click OK.  
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Step 5: Zoom to the extents of the drawing (View->Zoom->Extents). You will find the 
points from Sample1.txt imported into the current drawing. 
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Step 6:  Select Create Terrain from the "TerrainCAD" menu or type TCCreateTerrain at the 
AutoCAD command prompt and press Enter. At the AutoCAD  "select points, contours and 
breaklines", select all the points and press Enter. When prompted for the search radius type 
0 press Enter. At the AutoCAD command prompt, set the "TerrainCAD Options" as required 
and press Enter when done. A mesh is created as shown below. 
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Shaded view of the terrain mesh 

  

A terrain mesh is created using the current object creation parameters (color, layer, etc.) 
and the result of the operation is reported in the command window. 
In this tutorial we specified a search radius of zero, which means that the search radius 
should be ignored when creating the terrain mesh. In the next tutorial we shall specify a 
valid search radius and study its effect on the shape of the terrain mesh. 

 

Tutorial 2 - Effect of search radius 
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Tutorial 2 - Effect of search radius 

 
In this tutorial we will study the effect of the search radius parameter on the terrain mesh. 

 

Step 1: Delete the terrain mesh created in Tutorial 1. If you are starting from scratch then 
carry out steps 1 to 5 in Tutorial 1. 
 
Step 2: Select Create Terrain from the "TerrainCAD" submenu or type TCCreateTerrain at 
the AutoCAD command prompt and press Enter. At the AutoCAD command prompt "select 
points, lines and polylines" select all the points and press Enter. Specify a search radius of 
50 and press Enter. A mesh is created as shown below. 

   

 
Terrain mesh with holes 

 

You will find that the terrain mesh created has holes in it and is incomplete (see figure 
above). This is because the search radius we specified is not large enough. 
 
Step 3: Use AutoCAD's Undo command to undo the creation of the terrain mesh. Carry out 
the 2 step again and this time set the search radius to 70. The terrain mesh created this 
time does not have holes. 
This brings about an interesting question. Why don't we always set the search radius to a 
very large value (say 99999999) or zero (which is equivalent to a very large number since 
the search radius parameter is ignored for a value equal to zero)? The answer is we can't 
always do that because this may result in a terrain mesh which contains unwanted 
triangular faces. In fact the search radius parameter is prevents the generation of these 
unwanted faces. Lets see what unwanted faces are by an example. 
 
Step 4: Delete the terrain mesh and create it again by following the above steps using the 
TerrainCAD command with a search radius of zero. A terrain mesh will be created containing 
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829 faces (see message in the command window) as shown below. Zoom into the area 
marked in red. 
 

 
 

The boundary points (highlighted in red) are joined by unwanted needle shaped triangular 
faces. This happens because the boundary points in this point set do not describe a convex 
polygon. As a result the meshing algorithm treats all points as possible mesh edges and 
creates faces where it can. 

 

 
 

Now delete the terrain mesh and create it again using a search radius of 70. This time the 
terrain mesh contains 828 triangular faces (1 face lesser). The unwanted needle shaped 
triangular faces are no longer present in the terrain mesh (see figure below). 
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An intelligent use of the search radius parameter can yield accurate terrain meshes. 

 

Tutorial 3 - Create mesh from contours 
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Tutorial 3 - Create a terrain mesh from contours 

 
In this tutorial we will learn how to create a terrain mesh from contours. 

 
Step 1: Start AutoCAD 
 
Step 2: Select "Open" from the AutoCAD file menu. Browse for the file typically located at 
"C:\Program Files\SYCODE\TerrainCAD for AutoCAD\Samples\Contours.dwg" and click 
Open. 
 
Step 3: Zoom to the extents of the drawing (View->Zoom->Extents). You will find the 
contours from Contours.dwg imported into the new drawing. 

 

 
The above fig. shows contours imported into the new drawing. 

     
Step 4: Select Create Terrain from the "TerrainCAD" submenu or type TCCreateTerrain at 
the AutoCAD command prompt and press Enter.   
 
Step 5: At the AutoCAD "select points, lines and polylines, command prompt, select all the 
contours and press Enter. Specify a search radius of 0 and press Enter. At the AutoCAD 
command prompt, set the "TerrainCAD" options as required and press Enter when done. A 
mesh is created as shown below. 
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Picture of the mesh created. (Wireframe mode) 

   
A terrain mesh is created using the current object creation parameters (color, layer, etc.) 
and the result of the operation is reported in the command window. 

 

Tutorial 4 - Using breaklines 
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Tutorial 4 - Using breaklines 

 
 
In this tutorial we will see how to improve a terrain mesh by using breaklines. 
 
Step 1: Carry out steps 1 to 5 in Tutorial 3. 
 
Step 2: Zoom into the rectangular portion of the drawing (highlighted in red). 
 

 
 

Step 3: Observe the terrain at the vertices highlighted in red in the figure below and the 
faces in their vicinity. You will find that the terrain mesh would be more accurate if the red 
vertices were connected by edges since they represent the lower portion of a valley between 
two hills. However, this is not the case. Here is where breaklines play an important role. We 
will now add a couple of breaklines joining these red vertices and recreate the terrain mesh. 
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Step 4: Select the line tool and add the breakline from top to down and than bring it back 
on top to form a triangle or wherever needed.  Click the left button of the mouse or press 
Enter when done.  The new breaklines are shown in the figure below. 
 

 
 

Step 5:  Select Create Terrain from the "TerrainCAD" submenu or type TCCreateTerrain at 
the AutoCAD command prompt and press Enter.  At the AutoCAD "select points, lines and 
polylines command prompt, select only the breaklines and press Enter.  Do not select the 
contours. Set the Search Radius=0 at the AutoCAD command prompt and press Enter.  A 
new terrain is created which respects the new breaklines, as can be seen from the figure 
below. 
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This new terrain is more accurate than the previous one since its topology more 
appropriately describes the actual landscape. 
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